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Introduction 

Mailbox Central provides your organization with the unique possibility to implement and ensure a company-
wide standard email signature and identity. With Mailbox Central your email will stand-out, while effectively 
distributing your contact information and corporate brand. 
 
Mailbox Central automatically generates an email signature with each individual’s contact information, which 
is inserted into all outgoing emails. Mailbox Central is integrated with Active Directory and receives the contact 
information directly from it, thus eliminating typos while creating a uniform email signature. 
 
With Mailbox Central you can easily change the email signature in your organization when marketing a new 
product with its “Word interface”. Simply insert a new logo or change the links on the email signature and gain 
an inexpensive yet efficient way to market your product. 
 
Yours sincerely 
The Mailbox Central Team 
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CHAPTER 1.  

Introduction 

Mailbox Central provides your organization with the unique ability to implement and ensure a company-wide 
standard email signature and identity. Mailbox Central automatically generates an email signature with each 
individual’s contact information, which is inserted in all outgoing emails. Mailbox Central is integrated with 
Active Directory from which it receives contact information directly to create a uniform email signature. This 
document provides a detailed guide of how to install and use Mailbox Central. 

The document consists of the following chapters:   

 Introduction  

 Mailbox Central Installation 

 Using Mailbox Central  

o Mailbox Central Editor 

o Mailbox Central Outlook Add-in 

 Register License 

 Appendix 

 

The Introduction provides an overview of Mailbox Central; general information regarding Mailbox Central 

functionality.  

The Installation chapter describes how to install and set up all the Mailbox Central components.  

The Using Mailbox Central chapter elaborates on the Mailbox Central Editor functionality and Mailbox Central 

Outlook Add-in.  

The Register License chapter describes how to register the license for the software. 

The Appendix provides you with additional information related to Mailbox Central. 

In this chapter:  

 Definitions, Acronyms and Abbreviations  

 Mailbox Central Overview 
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Definitions, Acronyms and Abbreviations 

 

Term Definition 

AD (Active Directory) 
 A service that provides the means to manage the identities and 

relationships of network environments. 

Microsoft .NET Framework  

 A set of Microsoft software technologies for connecting information, 
people, systems, and devices. It enables a high level of software 
integration through the use of Web services: small, discrete, building-
block applications that connect to each other as well as to other, larger 

applications over the internet.  

Microsoft Exchange Server  
 A messaging platform that provides email, scheduling, online forms, and 

tools for custom collaboration and messaging service applications.  

Internet Information Services 
(IIS) 

 A Web server with integrated, reliable, scalable, secure, and 
manageable capabilities available over an intranet, the internet, or an 
extranet. It is a tool for creating a strong communications platform of 

dynamic network applications. 

 
Table 1 - Definitions, Acronyms and Abbreviations 

 

Mailbox Central Overview 

The main purpose of the Mailbox Central application is to facility the creation, deletion, and modification of 
signatures in Microsoft Outlook, Microsoft Outlook Web Access and their databases. Mailbox Central 
automatically generates an email signature with each individual’s contact information, which is inserted into all 
outgoing emails. Mailbox Central is integrated with Active Directory from which it receives the contact 
information directly, thus creating a uniform email signature. The product has two components: an Editor 
component and an Outlook Add-in component. 
 

 Mailbox Central Editor is a Windows application used to create, update and delete signatures. 

 Mailbox Central Outlook Add-in is a Microsoft Outlook add-in for users to get signatures and use in 

Microsoft Outlook. 

Instances 

The Mailbox Central Editor and the Mailbox Central Add-in can be installed on as many computers as required.  
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CHAPTER 2.  

Mailbox Central Installation 

System Requirement 

You can have an overview of System Requirements for Mailbox Central by visiting this web page. 

 

Installing Prerequisite Software 

Installing Microsoft.NET Framework 

Microsoft .NET Framework 4.6 is a .NET Framework redistributable package which you must install to run 
Mailbox Central.  

If you do not have the .NET Framework installed or you have an unsuitable version, the installer will stop the 
installation and display an error message.  

Microsoft .NET Framework 4.6 Redistributable Package is available here.  

 

NOTE: You can check whether you have .NET Framework installed or check the installed version in Control 

Panel, Add or Remove Programs. If .NET Framework is installed on your machine, it should appear on the list. 

Installing Microsoft Exchange Server 

The Mailbox Central works with Microsoft Exchange Server. Prior to installing Mailbox Central, you must make 
sure that Exchange Server is installed on a computer within your network.  

For information on how to install a Microsoft Exchange Server, please refer to the standard Microsoft Exchange 
Server documentation.  

 

Installing Mailbox Central 

Mailbox Central Editor 

Mailbox Central Editor should only be installed on the computer of the user who manages the company’s email 
signatures. 

Run the MCEditorSetup.msi file by double clicking it to start installing the Mailbox Central Editor. 

The Setup Wizard will now guide you through the remaining installation.  
 

http://www.add-on-support.com/support/index.php?/Knowledgebase/Article/View/52/6/system-requirement-for-mailbox-central
https://www.microsoft.com/en-us/download/details.aspx?id=48137
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Figure 1. Mailbox Central Editor Installer Welcome Page 

Click Next to proceed with the installation. The Setup Wizard now reports that it is ready to start the installation 
process. You can review the installation settings by clicking the Back button. If everything has been specified 
correctly, click the Install button to start the installation. 

 
Figure 2. Ready to install page 

The progress bar will provide a visual indication of how much of the program has been installed. 
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Figure 3. Installation progress 

When  the  installation is  complete,  you  will  see  a  screen that informs  you of  the result of the installation. 
Normally, you will see the screen displayed in the following figure. 

 
Figure 4. Installation completed 

To complete the installation of the Mailbox Central Editor, click the Finish button. 
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Mailbox Central Editor Options 

If the Mailbox Central Editor has not been configured yet, the Mailbox Central Editor Options window is always 
opened automatically to request you to configure.  

NOTE: It is required to open Outlook before starting MC Editor, failing which the following message appears: 

 
Figure 5. Outlook required  

To edit the configuration, click the Option button in the Home tab to change the System Configuration for 

Mailbox Central Editor. 

Specify the settings for Mailbox Central Editor: 

 Exchange Server: IP address of Exchange Server. 

 Domain: Domain to which the account (with user name and password below) belongs. 

 Username: username to logon to domain 

 Password: password to logon to domain 

 Email Address: Email of the account 

 Shared folder: where the data will be stored (data is created as .html, .rtf and .xml files). 

 Checkbox “Use picture in OWA signatures”: enable using picture in OWA signatures. 

 Virtual Path: if the signatures deployed to Microsoft Outlook Web Access use images, the images will 
be automatically copied into a folder. The virtual path plays an intermediate role as a path to access 
that folder via the internet. 

 Physical Path: Mailbox Central Editor uses this path to copy image into the folder. 

 Logging Level: type of logging 

 Open log folder: open the log folder that is located on the computer. 
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Figure 6. Option setting 

If you check on “Exchange Online” option, then 2 fields “Exchange Server” and “Domain” will be blurred. 
The difference for selecting “Exchange Online” option can be seen when you open a New Signature window 
and click User Fields: The property PostOfficeBox is available with Exchange On-Premise, meanwhile it is 
not available with “Exchange Online” option. 

 
Exchange On-Premise Exchange Online 
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Once finished, click the Verify button to verify the input data. Finally, click the OK button to save the 

information. 

Mailbox Central Outlook Add-in 

After installing and configuring Mailbox Central Editor, the shared folder must be created for Mailbox Central 
Outlook Add-in installation process. The shared folder should be empty before configuring Mailbox Central 
Editor (in Mailbox Central Editor Options window). 

 
Figure 7. The empty shared folder 

Please note that the Mailbox Central Editor must be configured before the Mailbox Central Outlook Add-in is 
installed (see the Mailbox Central Editor Options section for reference). After that, the Mailbox Central Editor 
automatically copies all files of the Add-in installer into the shared folder.  
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Figure 8. Shared folder 

The Mailbox Central Outlook Add-in will be installed in silent/unattended mode if the user is in Group Policy. 
So, the next step is to establish group policy and assign to user. 
 

NOTE: If Mailbox Central Outlook Add-in is installed manually, the file MailboxCentralAddin.XML must be 

copied to the add-in installation folder. 

Establish Group Policy and Assign to Users 

Microsoft Exchange Server 2007 or Microsoft Exchange Server 2010 is recommended. 
1. Open Group Policy Management.  
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Figure 9. Group Policy Management 

2. Right click on the “domain name” and choose “Create a GPO in this domain, and Link it here…” to 
create a new group policy. 

 
Figure 10. Create Group Policy Management 
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3. A window is invoked; write the group name in the “Name” textbox. Then click the OK button. 

 
Figure 11. New Group Policy Management 

4. Right click on the “group name” which is created at step 3 above and choose “Edit…” to configure 
GPO. 

 
Figure 12. Edit Group Policy Management Configuration 

5. The Group Policy Management Editor is opened. Expand the User Configuration\Policies\Window 
Settings; choose “Scripts (Logon/Logoff)” which is marked in red below. Then double click on “Logon” 
marked in green on the right panel to open the “Logon Properties” window. 
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Figure 13. Group Policy Management Editor 

6. In the next window, click the Add button.  

 
Figure 14. Logon Properties 
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7. In the “Edit Script” window, browse to the script file (.bat file) which is automatically copied into the 
shared folder after installing Mailbox Central Editor. Then click the OK button. 

 
Figure 15. Edit Script 

8. In the “Logon Properties” window at step 6, click the OK button to finish. 
9. Right click on the “group name” in the “Group Policy Management” window again, and choose 

“Enforced” (to apply all settings above immediately). 

 
Figure 16. Group Policy Management 

Repeat these steps for creating group policy to install Mailbox Central Outlook Add-in for Microsoft Outlook 64 
bit. 
 

Removing Mailbox Central 

You may want to remove some or all of the installed Mailbox Central components. For instructions to remove 
Mailbox Central, refer to the Appendix B: Remove Mailbox Central Components section in this guide. 
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CHAPTER 3.  

Using Mailbox Central 

Using Mailbox Central Editor 

Mailbox Central Editor Overview 

Mailbox Central Editor provides the ability to create, edit and delete content of the signature template. 
Signatures are stored in a shared folder before being deployed to users. 
After a signature is saved to a shared folder, Mailbox Central Outlook Add-in is responsible for deployment. 

Mailbox Central Editor Main Screen 

Upon start up, the Mailbox Central Editor main screen displays all the email signatures that are stored on the 
server. 

 
Figure 17. Main screen 

If the LAN is not available or the application cannot access to the shared folder because of any reasons, a 
message appears that asks you to re-configure the application. 

 
Figure 18. Message configuration 

Click Yes button to start configuring or No button to exit the application. 
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Toolbar Home Tab 

The Home tab contains buttons for the application’s main functions. 
 

Button Description 

 

 Access the “Buy the product” dialog box for instructions on how to 
purchase products. 

 

 Create new signature. The signature will show in the Signature 
List (Figure 2 – Signature List) 

 

 Edit existing signature. The editing procedure is the same as 
creating a new signature. 

 

 Delete an existing signature. 

 User can delete multi signatures at the same time by pressing 
Shift + left mouse clicking. Then click Delete button. 

 
 Deploy the signature to Microsoft Outlook for user to use. 

 

 Deploy the signature to Microsoft Outlook Web Access for user to 
use. 

 
 Specify the default signature for Microsoft Outlook. 

 
 Change the configurations for Mailbox Central Editor. 

 

 Filter the users who are deployed signature to Microsoft Outlook 
or OWA. 

 
Table 2 – Home Tab 

Toolbar Help Tab 

Button        Description 

 
 Access the User Guide file. 

 

 Access Product Home Page; News Page; Knowledge Base Page 
and Add-On Products’ Home Page. 

 
 Shows information about the software and the developer. 

 
Table 3 – Help Tab 
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File Tab 

 

 Contains buttons to quickly create/edit/delete signatures, 
import/export signatures and exit the application. 

Table 4 – File Tab 

Signature List 

The Signature List contains all email signature templates that are created by Mailbox Central Editor. This list 

will provide you the Signature Name, Description, Date of Creation, Date of Modification and Status of 
Signature. By default, Mailbox Central provides you three new signature samples after installation. 

The “Read Only” option is not checked by default when creating a new signature, so that user can edit the 
signature in Microsoft Outlook manually. Check the checkbox to set the editing permissions of the signature. 

 
Figure 19. Signature List 

User Area  

The User Area of the Mailbox Central Editor displays the names and email addresses of all the users who 
have been specified to use the selected signature.  

 
Figure 20. User Area 

Signature Preview 

To preview the user signature, double click on the user in the User Area. You can preview the signature in 
this window before deploying. 
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Figure 21. Signature Preview 

Create/Edit Signatures 

Click the New button on the Home tab to create a new signature or select an existing signature in the list and 
click the Edit button to open the Editor. 

 
Figure 22. Editor 

The Editor provides the most common editing commands. 

Click the Save & Close button to save the signature. If the signature is new, a new window will appear that 

asks you to name the signature. 



 

CHAPTER 3 

Using Mailbox Central 21 
 

 

 
Figure 23. Save new signature 

Insert User Fields 

Mailbox Central allows you to insert User Fields into the signature template. This ensures that the individual 
user email signature is always up to date with the correct contact information.  To insert User Fields, click the 
User Fields button and select an item in the list that you want to include in the signature template. 

 
Figure 24. Insert User Fields 

Insert Pictures 

To insert a picture or logo in your signature template, just click on the Picture button to browse for the 

appropriate picture/logo. You can also copy and paste the picture directly into the signature template. 

Insert Hyperlinks for Pictures 

To create a hyperlink for a picture, select the picture, right click on it and choose Hyperlink menu to open 

the Hyperlink window. Then insert address of the hyperlink. 
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Figure 25. Insert Hyperlink for Pictures 

After inserting the hyperlink, move the mouse on the picture, you will see a tooltip tells you know the link. 

 
Figure 26. Tooltip of Picture Hyperlink 

To edit picture hyperlink, right click on the picture and choose the Edit Hyperlink… menu to replace the 
hyperlink. 

Insert Hyperlinks for Text 

To add a hyperlink to your signature template, click the Hyperlink button. You can now insert the following 

information: 
 

 Text to display in the signature. 

 Address of the hyperlink. 

 
Figure 27. Insert Hyperlink for Text 
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User Properties 

There are 4 cases for all user-inserted properties that occur in the following order: 
1. When a user’s field name in the Exchange Server has a value, Mailbox Central gets this value by 

default.  
2. If not, Mailbox Central uses the value of “Default value”.  
3. If the “Default value” column is null and the checkbox “Remove the whole line if no value” is not 

checked: keep the line which contains the field name. 
4. If the “Default value” column is null and the checkbox “Remove the whole line if no value” is checked: 

remove the whole line. 
 

                              
 

 
Figure 28. User Properties 

NOTE: You can click on the heading “Field name” to sort the list. 

Import and Export Signatures 

Mailbox Central lets you easily to export signatures from the signature list, which can be used as a backup or 
for importing into other computers using this application. 

 Export: you can export one or many signatures at the same time.  



 

CHAPTER 3 

Using Mailbox Central 24 
 

 

Firstly, choose the signatures you want to export, click Export menu on File tab. A window opens 

and tells you to name the exporting file. 

 

Figure 29. Export Signatures 

Click Save button to close the window. Then a message box opens and lets you know the successful 
exporting. 

 
Figure 30. Successful Exporting 

 Import: click Import menu on the File tab, a window opens and you will now be asked to select the 
backup file (export file) which is located on the computer. 
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Figure 31. Backup file 

Deploy to Outlook/OWA 

NOTE: If you have opened Microsoft Outlook before, you must start Mailbox Central Editor as the same way 

as Microsoft Outlook. It means that if you have opened Microsoft Outlook as administrator, you must open 
Mailbox as administrator too. Otherwise both of them must be opened as normally by double clicking on their 
icons. 
 
When a signature template is created, it is stored in the shared folder. You now have to deploy the signature 
to users who need the same format template. The signature is deployed to: 
 

 Microsoft Outlook: Mailbox Central Editor integrates with the Active Directory from which it receives 
contact information directly. Then the Mailbox Central Outlook Add-in gets signatures for use in 
Microsoft Outlook. 

 Microsoft Outlook Web Access: most contacts exist on the Exchange Server, so the Mailbox Central 
Editor just integrates directly and gets signatures without using the Mailbox Central Outlook Add-in. 
 

1. Click the Deploy to Outlook/Deploy to OWA button, a new window opens the list of users to deploy. 
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Figure 32. Deploy Signature To Outlook 

2. Click the Add button to get a list of users/groups from your global address list (GAL) 

 
Figure 33. Add Users 

NOTE: It takes considerable time to add a large number of users from the Global Address List. If you are using 

Microsoft Outlook 2007, you can increase the performance of the Mailbox Central Editor by adding users into 
a group first and then selecting the group to add into the signature. This way, the performance of the Mailbox 
Central Editor will significantly improve when adding more than 1000 users at a time. 
 
Choose users from the list and click the Add button to add to the textbox. To remove users, select and click 

the Delete key on the keyboard. 
When you have chosen all users who should use this signature, click on the OK button. 

 
3. You now have to choose the appropriate option for each user. Should the signature be the “Default For 

New” or the “Default For Replies/Forwards” or both? 
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Figure 34. Set Default Signature 

In order to remove users from the list, click Remove button or Remove All. Check the checkbox Select All For 
New or Select All For Replies/Forwards to set option for user before deployment. 
 

4. Click the Deploy button to deploy to Microsoft Outlook/OWA or the Close button (same with Escape key 

and Close form button (X)) to exit without deployment. 
 

NOTE:   

 If you click the Close button/Escape key/Close form button (X) to exit without deployment, all the users 

(comprise un-deployed users) will be kept and displayed in the User Area of Main window. 

 In case the users in the list have been removed, the User Area is also empty. 
 

If the deployment is not successful, an information appears at the bottom of the dialog tells you know the 
deployment details. 

 
Figure 35. Message Information 

Click the arrow to see the deployment details. 
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Figure 36. Deployment Details 

NOTE: If the content of signature has been edited, the signature will be only deployed to Microsoft Outlook 

automatically; but the signature must be redeployed to OWA manually. 

- Besides, if other information of signature (such as “Name”, “Description”, “Read only”) has been changed, 
the signature must be redeployed to Microsoft Outlook and OWA. 

- When the signature has been updated and redeployed to OWA, the application will reset all options under 
OWA. 

 

Change Default for Outlook 

The Change Default function provides you the ability to manage the default signatures for Outlook for all users 

in the system. This option is only available for Microsoft Outlook, not for Microsoft Outlook Web Access which 
uses a unique signature for each user. 

Click the Change Default button to open the list of users with signatures and do the following: 

 Choose users from the Deployed User List and click the Add/Add All button for a custom user list. To 
remove users, select and click the Remove/Remove All button. 

 On the right panel, click to open the list box and choose the signature template you want the user to 
use. There are three options: Default For New (will be applied for all new messages), Default For 
Reply/Forward (will be applied for all reply/forward messages) or both. 

 Click the Change Default button to finish. 
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Figure 37. Change Default 

NOTE: You can use the quick search to search the user in the list. Press F6 to focus on deployed user list and 

F7 to focus on selected user list when using application without mouse. 
 

 

Using Mailbox Central Outlook Add-in 

NOTE: The term “Mailbox Central Add-in” refers to both Mailbox Central Add-in for 32 bit and 64 bit 

The Mailbox Central Add-in is a component of Mailbox Central installed into each user’s Microsoft Outlook. 
The Mailbox Central Add-in is responsible for updating signatures or the changes of information in a user’s 
signature to ensure that the signature is new and correct. 

There is no graphical user interface for the Mailbox Central Add-in. It is installed silently into Microsoft Outlook 
and listens to the event. Whenever Microsoft Outlook starts up, the Mailbox Central Outlook Add-in runs and 
checks for the latest signature. 

The Mailbox Central Outlook Add-in works independently, so the user does not need to do anything. Properties 
of signatures are established by the editor via the Mailbox Central Editor. Thus, the Mailbox Central Outlook 
Add-in gets the signature and assigns all properties to the signature (e.g. “Read only” properties, “Default for 
new” properties, “Default for Reply/Forward” properties).  
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Register License  

There are three kinds of license:  

 License for Microsoft Outlook deployment: if user uses this kind of license, some functions are limited 
when deploying signatures to Microsoft Outlook. 

 License for OWA deployment: some functions are limited when deploying signatures to OWA. 

 License for both Microsoft Outlook and OWA deployment: all of the functions of Mailbox Central are 
available for use. 

By default, Mailbox Central will run as a trial version for 30 days with up to 5 users. After this period, Mailbox 
Central will stop working.  

When the trial version runs for the first time or a version which the license has been deleted runs, a message 
box will appear with information about number of trial days and limited users. 

 
Figure 38. License Message 

Click the OK button to open the applications.  

 

NOTE: The splash screen will appear each time the Mailbox Central trial or time-limited version starts. 

 
Figure 39. Trial Version 
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Please note that the text which is marked in red has three status colors according to the remaining trial days: 

- Blue: 30 days  

- Yellow: 10 days 

- Red: 5 days 

To run the full version, please register Mailbox Central by doing the following. 

If you have obtained a license key (*.lic file) from Add-On Products or a reseller, copy that license key file to 
the installation folder (e.g. C:\Program Files\Add-On Products\Mailbox Central Editor\3.0) after installing 
Mailbox Central Editor. New license has function changes for signature deployment will be also updated. 

 
Figure 40. Mailbox Central Editor folder 

The editor is able to edit and save signatures for any number of users but only to deploy signatures subject to 
the license limit. For example, if you have a license with 5 users, you can only deploy signatures to 5 users 
but are able to create and edit signature for more than 5 users. 

If you deploy signatures for more accounts than the number that the license allows, the following message will 
be shown and the deployment will discontinue. 

 
Figure 41. Over the maximum number of users deployed 

To see the maximum number of users and your license’s expiration date, click the About Mailbox Central 

button on the Help tab of the Mailbox Central Editor window. 
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Figure 42. About Mailbox Central 

After the expiration date Mailbox Central can no longer be used. When opening the program, the splash 
screen tells you the license has been expired. 

 
Figure 43. License Has Expired 

Click the Buy the product button to open the “Buy the product” window or click the Exit button to exit Mailbox 

Central. 

If you want to extend the period of use or increase the number of users, you can purchase new licenses and 
overwrite the license key into the old one. 

When a license is expired, you can also copy the new license to active the application again. 

With this last kind of license, Mailbox Central can be used and will never expire. 
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Buy the product 

To contact Add-on Products for a Mailbox Central license, click the Buy the product button. The Buy the 
product window will appear: 

 
Figure 44. Buy the product 

In this window, you can find the Add-on Products’ phone number and website link to look for resellers. 

You can also send a request directly to Add-On Products by completing the blank fields in the Buy the product 
window and click Send request. The fields marked by “*” are required; if there is no information in these fields, 

the request will not be sent. 
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CHAPTER 5.  

Appendix 

Appendix A: Installation problem 

1. If the Mailbox Central Outlook Add-in is not automatically installed after installing Group Policy, the 
user has to click on the *.bat file which is in the shared folder to install the Mailbox Central Outlook 
Add-in. (This user must have Administrator permission) 

2. If the user changes the path of the shared folder in the options window, the path of the script file in 
Group Policy has to be reconfigured. 

3. If the Mailbox Central Outlook Add-in has not been installed or cause of errors, user can get signatures 
from shared folder to local by using a small tool which is located under the “AddinRunTime” folder of 
shared folder. 
The user can run directly this tool by clicking on the RunTime\MCAddin.exe file. It will return a message 
box saying successfully or failed depending on whether it gets signature well or not. In other case it 
will say there is no new signature.  
For more useful the tool should be used in silent mode by using Group Policy to apply for RunAddin.bat 
script. 
 

NOTE: When running RunAddin.bat script, a net mapped driver so called X will be created. Therefore if X has 

already existed in the system the user must edit the batch file manually to avoid the conflict, i.e. to replace 
the X by another letter.  
 

Following is an example:  

The original batch file looks like so: 

 
::Please be noted that if Driver “X” has existed in your system then you cannot use it. 

Please use another letter instead and start the batch file again. 

IF EXIST  X:\  ( 

 Echo Drive letter already exist, the batch file has stopped, please contact 

Administrator to resolve the problem by selecting another drive letter. 

)  

ELSE ( 

net use X: "\\SERVERNAME\SharedFolder\AddinRunTime\RunTime"  

X:\MCAddin.exe 0 

net use X: /delete /y 

) 

Exit 

 
The new batch file could be following in case Y has not existed yet: 
 

::Please be noted that if Driver “X” has existed in your system then you cannot use it. 

Please use another letter instead and start the batch file again. 

IF EXIST  Y:\  ( 

 Echo Drive letter already exist, the batch file has stopped, please contact 

Administrator to resolve the problem by selecting another drive letter. 

)  

ELSE ( 

net use Y: "\\SERVERNAME\SharedFolder\AddinRunTime\RunTime"  

Y:\MCAddin.exe 0 

net use Y: /delete /y 

) 

Exit 
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Appendix B: Remove Mailbox Central Components 

Remove Mailbox Central Editor 

You may want to remove the installed Mailbox Central Editor. On the Start menu, select Control Panel, Add 
or Remove Programs. The list of all programs installed on your computer will appear. 

 
Figure 45. Add or Remove Programs window 

Select the Mailbox Central Editor in the list and click Uninstall.  
 
Post-Removal Cleanup:  

The Mailbox Central Setup Wizard removes all the installed components from your computer. However, it 
removes only the files and folders that were previously created. Some of the files will not be removed. These 
are: the new files in the folder to which Mailbox Central was installed. By default, Mailbox Central installation 
folder is at: C:\Program Files\Add-On Products\Mailbox Central Editor\3.0. You will need to manually remove 
these files and folders. 

NOTE: If you changed the names of the files or folders belonging to Mailbox Central, the Mailbox Central Setup 

Wizard will not be able to remove them. Rename files and folders their original names before you begin 
removing Mailbox Central or remove them manually.  

Remove Mailbox Central Outlook Add-in 

You may want to remove the installed Mailbox Central Outlook Add-in. On the Start menu, select Control 
Panel, Add or Remove Programs. The list of all programs installed on your computer will appear.  
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Figure 46. Add or Remove Programs window 

Select the Mailbox Central Outlook Add-in in the list and click Remove.  

 
Appendix C: Setting up Permissions for an Exchange Server Account 

[Exchange 2007] Granting Full Access Permissions through Exchange Management Shell 

All mailboxes should be granted Full Permissions with the Administrative account (e.g. ‘mcadmin’). To do so, 
execute the following command in the Exchange Management Shell: 

get-Mailbox [-Identity <MailboxIdParameter>] [-Credential <PSCredential>] [-DomainController 
<Fqdn>] [-OrganizationalUnit <OrganizationalUnitIdParameter>] [-ReadFromDomainController 
<SwitchParameter>] [-RecipientTypeDetails <RecipientTypeDetails[]>] [-ResultSize <Unlimited>] [-
SortBy <String>]| Add-MailboxPermission -Identity <MailboxIdParameter> -AccessRights 
<MailboxRights[]> -User <SecurityPrincipalIdParameter> [-Deny <SwitchParameter>] [-
DomainController <Fqdn>] [-InheritanceType <None | All | Descendents | SelfAndChildren | 
Children>] 

For example, if the complete email address of the mailbox which is to be given Permissions is 
‘MC1@somedomain.com’ and the administrative account with which the mailbox is to be given rights is 
‘admin@somedomain.com’, the command would be: 

Get-Mailbox –OrganizationalUnit MC1 –Resultsize Unlimited | Add-MailboxPermission –User Admin –
AccessRights FullAccess –InheritanceType All  
 

NOTE: The Exchange Management Shell can be launched from StartProgramsMicrosoft Exchange 

Server 2007. 

 

Appendix D: Log mode 

The Log mode is enabled silently after Mailbox Central is installed to monitor the events and errors as the 

application runs. 

The log is recorded in Event Log by default. 

You can change the log level by changing the following tags: 

There are some cases: 

 To monitor events: open the Logging.config file, find the <loggingConfiguration> tag, change 
the properties filter=“Information”. 
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 To monitor errors: open the Logging.config file, find the <loggingConfiguration> tag, change 

the properties filter=“Error”. 

 To monitor both events and errors: open the Logging.config file, find the <loggingConfiguration> 
tag, change the properties filter=“Verbose” (the application is using these properties by default). 

To disable the Log mode, open the MCEditorLogging.config file, find the <loggingConfiguration> tag, 
change the properties filter=“None”. 
 

If you want the log to be exported to a log file, you can make some modification in the 
MCEditorLogging.config: 

 
Figure 47. MCEditorLogging.config 

You can also change the location of the log file in the MCEditorLogging.config: 

(Example: 

- Mailbox Central Editor:   %LOCALAPPDATA%\Add-On Products\Mailbox 
Central\3.0\Log\MCEditor.log 

- Mailbox Central Add-In:  %LOCALAPPDATA%\Add-On Products\Mailbox 

Central\3.0\Log\MCAddin.log 

(please note that the folder “3.0” will be changed depend on the version of Mailbox Central)). 

 

Appendix E: How to enable a message box in add-in to show that there is a 
new signature 

This message is used to inform user of the signatures that have been updated, which shows up when user 
opens Outlook. I might look like this: 
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Figure 48. Message box 

In order to enable this message box, follow these steps: 
- Go to Addin folder (by default, it is: C:\Program Files\Add-On Products\Mailbox Central Outlook 

Addin) 

 
Figure 49. Add-in installation folder 

- Open the config file MailboxCentralOutlookAddin.dll with Notepad 

- Look for the key “ShowMessageBox” in the config file 

  
Figure 50. Config file 
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- Change the value from ‘False’ (by default) to ‘True’. 

- Save the config file. 

NOTE: If you want to use Group Policy to run AddinRunTime and want to enable the message box, follow these 

steps: 

- Go to “AddinRunTime” folder of shared folder 

 

- Open RunAddin.bat (for 32-bit Outlook) or RunAddin64.bat (for 64-bit Outlook) with Notepad and 

look for “MCAddin.exe” 

 

- Change its value from 0 to 1 as highlighted in the above figure. 

- Save the .bat file. 

 

 


